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ВВЕДЕНИЕ 

В соответствии с учебным планом студенты второго курса направ-
ления подготовки 38.03.05 «Бизнес-информатика» изучают дисциплину 
«Моделирование бизнес-процессов».  

Цель учебно-методического пособия – формирование знаний о ме-
тодологии ARIS моделирования бизнес-процессов, навыков моделиро-
вания в нотациях EPC, BPMN, умений создавать диаграммы Organization 
chart, Process Landscape. 

В данном пособии рассмотрены основные возможности ARIS Ex-
press – open source – инструментального средства моделирования биз-
нес-процессов и их окружения с использованием методологии ARIS. 
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1 ARIS – МЕТОДОЛОГИЯ МОДЕЛИРОВАНИЯ  
БИЗНЕС­ПРОЦЕССОВ 

Начало разработке методологии ARIS положил профессор Август 
Шеер (prof. Scheer A.-W.). Им была предложена концепция, включаю-
щая представление процесса с использованием нескольких аспектов мо-
делирования, т.е. в комплексном анализе бизнес-процессов с последую-
щей интеграцией в единую систему. Собственно методология ARIS 
расшифровывается как ARchitecture of Integrated Information Systems –
проектирование интегрированных информационных систем. Архитекту-
ра ARIS создает основу для разработки и оптимизации интегрированных 
информационных систем, а также для описания их реализации.  

Методология ARIS очень распространена в Германии. Использо-
вание методологии в организациях других стран тесно связано с проек-
тами внедрения программного продукта SAP для управления ресурсами 
предприятия (ERP-система). SAP использует в модуле настройки систе-
мы часть моделей методологии ARIS для адаптации общего функциона-
ла системы под нужды конкретной организации. 

В пособии для разработки моделей согласно методологии ARIS 
используется свободно распространяемое программное обеспечение 
ARIS Express, которое поддерживает только девять нотаций моделиро-
вания: 

 Карта процессов (Process landscape); 
 Организационная диаграмма (Organizational chart); 
 Бизнес-процесс (Business process); 
 Карта систем (System landscape); 
 ИT-инфраструктура (IT-infrastructure); 
 Модель данных (Data model); 
 BPMN диаграмма версии 2.0 (BPMN diagram); 
 Доска (Whiteboard); 
 Общие диаграммы (General diagram). 
Платформа ARIS представляет ряд продуктов, предназначенных 

для структурированного описания, совершенствования (проектирова-
ния), автоматизации и контроллинга деятельности организации.  

Четыре типа платформ, которые предоставляют пользователям 
различный функционал: 

ARIS Strategy Platform:  
 проектирование стратегических целей;  
 проектирование бизнес-стратегии;  
 проектирование ССП; 
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 проектирование функциональных стратегий, в том числе ИТ-
стратегии; 

 визуализация достижений стратегических целей и KPI.  
ARIS Design Platform: 
 проектирование моделей бизнес-процессов; 
 проектирование архитектуры предприятия; 
 разработка скриптов и автоматизация отчетности и регламента-

ции деятельности; 
 симуляция процессов. 
ARIS Controlling Platform: 
 мониторинг ключевых показателей процесса;  
 интеграция с учетными системами;  
 управление рисками и контролями. 
ARIS Implementation Platform: 
 интеграция с решениями SAP;  
 процессное внедрение SAP;  
 подготовка процессов под внедрение SAP.  
Продукт ARIS Express относится к продуктам платформы ARIS 

Design Platform. 

1.1 Органиграммы 

Организационная диаграмма (Organizational Chart) описывает 
иерархию структуры организации.  

Организационная структура компании может быть следующего 
типа: функциональная, матричная и проектная. 

Функциональная организационная структура: каждый сотрудник 
(кроме руководителя компании) имеет только одного непосредственного 
руководителя, отделы формируются из сотрудников со схожим функ-
ционалом (отдел продаж, отдел закупок, производственный отдел, отдел 
логистики и т.п.). 

Проектная организационная структура: каждый проект образует 
автономное подразделение, в которое могут включаться различные спе-
циалисты, при этом традиционные подразделения, формируемые по функ-
циональной направленности, оказывают сервисную поддержку проектам: 
бухгалтерское обслуживание, юридическое обслуживание и т.п. 

Матричная организационная структура: каждый сотрудник имеет 
двойное подчинение, работает под началом руководителя функциональ-
ного подразделения, к которому относится по своей должности, и также 
подчиняется руководителю проекта, над которым работает. Сотрудник 
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может быть участником сразу многих проектов и даже быть руководи-
телем некоторых проектов. Различают три основных типа матрицы: сла-
бую, сильную, сбалансированную. 

Слабая матричная структура характеризуется сохранением власт-
ных полномочий за руководителями подразделений.  

Сильная матричная структура выделяет менеджеров проектов в от-
дельное подразделение, которое обладает значительными полномочиями 
по распределению ресурсов (в том числе и трудовых). 

Сбалансированная матричная структура делает акцент на сотруд-
ничестве с менеджерами проектов и обслуживании проектов функцио-
нальными подразделениями, обеспечение поддержки проектов входит  
в должностные обязанности руководителей подразделений. 

Организационно-штатная структура – это совокупность организа-
ционных единиц (структурных подразделений и должностных лиц) и их 
взаимоотношений в рамках существующих бизнес-процессов (таблица 1).  

 

 
Таблица 1 – Графические примитивы нотации Organizational Chart в ARIS Express 

Графическое представление Наименование Описание 

 

Organizational unit 
(организационная 
единица) 

Служит для выделения 
функциональных  
подразделений в структуре 
организации 

 

Role (роль) Предназначено  
для определения группы лиц 
со схожими функциональными 
обязанностями 

 

Person (конкретное 
лицо) 

Обозначает лицо, входящее 
в подразделение  
и выполняющее  
определенную роль 

 

Location  
(местоположение) 

Фиксирует местоположение 
подразделения или персоны 
 

 
Рассмотрим бизнес-процесс верхнего уровня «Подобрать и нанять 

сотрудника». Со стороны организации в нем участвуют:  
 руководитель подразделения, в котором открылась вакансия  

(в связи с увольнением сотрудника, расширением штата, ротацией кад-
ров и т.п.); 

 руководитель отдела кадров; 
 сотрудник отдела кадров: менеджер по подбору персонала; 
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 сотрудник отдела кадров: менеджер по трудовым отношениям; 
 сотрудник подразделения, в котором открылась вакансия; 
 сотрудник службы безопасности. 
Возможная организационная структура отдела кадров представле-

на на рисунке 1. 
 

Отдел кадров

Менеджер
по подбору
персонала

Менеджер
по трудовым
отношениям

Секретарь отдела
Начальник отдела

кадров

 
 

Рисунок 1 – Структура подразделения – отдел кадров 
 
В бизнес-процессе «Подобрать и нанять сотрудника» каждый  

из участников выполняет определенные функции (таблица 2). 
 

Таблица 2 – Функции участников процесса «Подобрать и нанять сотрудника» 

Сотрудник 
предприятия 

Функции Требования 

1 2 3 
Руководитель 
подразделения 

Подает заявку на подбор 
кандидата в отдел кадров 

Своевременная подача заявки. 
Указание основных требований  
к кандидату согласно шаблону. 
Указание основных должностных 
обязанностей 

 Проводит собеседование 
с потенциальными  
кандидатами на вакансию 

Своевременно назначает личное  
собеседование потенциальным  
кандидатам  

 По результатам личного 
собеседования составляет 
краткое резюме  
о кандидате на вакансию 

Указание соответствия  
профессионального уровня кандидата 
заявленным требованиям 

 Дополняет заявку на подбор 
кандидата по результатам 
неуспешного финального 
собеседования 

Указывает дополнительные требования 
к кандидату, если потенциальные 
кандидаты не прошли финальное  
собеседование 
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Продолжение таблицы 2 

1 2 3 
 Принимает решение  

о приеме кандидата  
на работу  

В случае прохождения кандидатом 
проверки сотрудником службы  
безопасности 

 Подписывает заявление  
о приеме на работу  
и согласовывает  
с кандидатом дату  
фактического выхода  
на работу  

Личное заявление оформляется  
кандидатом и подписывается  
руководителем подразделения 

 Назначает сотрудника  
отдела для адаптационного 
периода 

Сотрудник готов к наставничеству  
и имеет на него время 

 Проводит первичный  
инструктаж по охране 
труда на рабочем месте 

Зафиксировать факт прохождения  
инструктажа в журнале 

Менеджер  
по подбору  
персонала 

В соответствии с заявкой 
на подбор кандидата 
формирует профиль 
должности 

Профиль должности содержит  
информацию о личных качествах, 
знаниях, умениях и навыках,  
об ограничениях (образовательный, 
возрастной ценз, семейное положение 
и т.п.). 
Информация профиля должности 
разделяется на внутреннюю  
(служебную) и публичную 

 В зависимости  
от требований к вакансии 
выбирает источники  
привлечения кандидатов 
на вакансию 

Источники привлечения кандидатов: 
 сотрудники предприятия (кадровый 
резерв); 
 участники стажировок (практик); 
 выпускники профильных учебных 
заведений; 
 внешний поиск (рекрутинговые 
сайты, социальные сети и т.п.); 
 сотрудничество с кадровыми  
агентствами; 
 база данных о бывших сотрудниках 
(увольнение по собственному  
желанию, сокращению штата,  
профессионализм сотрудника  
не был причиной увольнения); 
 база резюме 
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Продолжение таблицы 2 

1 2 3 
 Составляет рекламное 

объявление о вакансии 
Соответствие объявления пункту 6  
Закона РФ от 19.04.1991 № 1032-1 
(ред. от 01.05.2017) «О занятости  
населения в Российской Федерации» 
и статье 13.11.1 «Кодекса Российской 
Федерации об административных 
правонарушениях» от 30.12.2001  
№ 195-ФЗ (ред. от 29.07.2017)  
(с изменениями и дополнениями, 
вступившими в силу с 06.08.2017) 

 Подготовка к интервью Включение узкоспециализированных 
вопросов при закрытии определенных 
вакансий 

 Проводит первичный  
отбор кандидатов 

Заполненная анкета для кандидата  
на вакансию (шаблон утверждается 
для предприятия), собственное  
резюме кандидата 

 Договаривается о личной 
встрече с кандидатами 

График встреч утверждается  
руководителем отдела кадров  
и заказчиком (руководителем  
подразделения с открытой вакансией) 

 Отказ кандидату  
на любой стадии  
предварительного  
взаимодействия  
с кандидатом 

Корректное сообщение о решении  
не в пользу данного кандидата  
без указания причин и личных  
замечаний, которые могут повлечь 
судебные разбирательства с компанией 
и повредить ее репутации на рынке 
труда 

 Проводит собеседование 
с кандидатами  
и формирует оценку  
кандидата по результатам 
интервью 

Оценка кандидата включает  
заключение менеджера по подбору 
персонала по каждому пункту  
профиля должности для вакансии 

 Результаты интервью, 
тестирования  
и дополнительная  
информация передаются 
руководителю  
подразделения  
с открытой вакансией 

Руководитель получает по каждому 
претенденту анкету, резюме, оценку 
по результатам интервью (тестированию) 
и дополнительную документацию 
(например, заключение сотрудника 
службы безопасности) 

 Проверяет рекомендации 
с предыдущих мест  
работы 

Уточняется должность соискателя  
на предыдущем месте работы, состав 
функциональных обязанностей,  
характеристика бывшими сослуживцами 
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Продолжение таблицы 2 

1 2 3 
Сотрудник 
службы  
безопасности 

Проверяет информацию 
анкеты кандидата в случае 
принятия положительного 
решения руководителем 
подразделения  

Комплексная проверка по доступным 
базам, обращение к бывшим  
сослуживцам кандидата и т.п. 

Руководитель 
отдела кадров 

Утверждает программу 
подбора кандидата  
на вакансию 

Программа содержит источники  
привлечения кандидатов, рекламное 
объявление для размещения  
в публичном пространстве,  
структурированное интервью 

Менеджер  
по трудо- 
устройству  

Оформляет кандидата  
на работу на основании 
заявления 

Пакет документов: 
 оригинал трудовой книжки; 
 паспорт; 
 идентификационный налоговый 
номер; 
 копию документа об образовании 
(с вкладышами); 
 копию свидетельства  
об общеобязательном государственном 
социальном страховании (пенсионном 
страховании); 
 копию военного билета  
(все страницы); 
 копию свидетельства о браке; 
 копию свидетельства о рождении 
детей до 18 лет; 
 … 

 Знакомит нового  
сотрудника под роспись  
с документами,  
регламентирующими  
его деятельность 

Перечень документов для вступления 
в должность 
– приказ о приеме на работу; 
– трудовой договор; 
– должностная инструкция; 
– положение о коммерческой тайне 

 Проводит вводный  
инструктаж нового  
сотрудника по охране труда

Зафиксировать факт прохождения  
инструктажа в журнале 

Сотрудник 
подразделения – 
куратор нового 
сотрудника  
на адаптаци-
онный период 

Знакомит нового  
сотрудника с рабочим  
местом, договаривается  
о формате  
консультирования  
и поддержки 

Предоставление сотруднику  
стандартов по бизнес-процессам,  
руководств по используемому  
программному обеспечению и т.п. 
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Можно дополнить организационную структуру указанием зон от-
ветственности для организационных единиц (списком выполняемых 
функций). Для рассматриваемого бизнес-процесса пример такой органи-
граммы представлен на рисунке 2. 

 

� Составлять профиль
должности для
вакансии;

� вести базы резюме;
� составлять объявления

о вакансиях;
� проводить интервью с

соискателями;
� формировать оценку

кандидата на вакансию;
� проверять

рекомендации
кандидата.
 

� Формировать личное
дело нового
сотрудника;

� проводить вводный
инструктаж по охране
труда;

� ознакомить нового
сотрудника с
нормативными
документами,
регулирующими его
деятельность.

Отдел кадров

Менеджер
по подбору
персонала

Менеджер
по трудовым
отношениям

Секретарь отделаНачальник отдела
кадров

� Контролировать
соблюдение
законодательных норм;

� утверждать
должностные
инструкций;

� утверждать внутренние
документы
подразделения

 
 

Рисунок 2 – Органиграмма, дополненная функциональными обязанностями  
сотрудников отдела кадров 

 
 
Для более масштабной организации служба управления персона-

лом может иметь оргструктуру, представленную на рисунке 3. 
 

Служба управления
персоналом

Отдел кадров
Отдел обучения

и развития
Отдел труда

и заработной платы

 
 

Рисунок 3 – Органиграмма службы управления персоналом 
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1.2 Карта процессов 

Карта процессов (Process Landscape) описывает иерархию про-
цессов и показывает, на какие подпроцессы делятся основные процессы 
организации.  

Последовательность процессов в модели указывает, какие процес-
сы вызваны другими процессами или запускают другие процессы. Карта 
процессов часто используется для схематического отображения всех 
процессов, которые существуют в организации. 

Основные примитивы нотации Process Landscape представлены  
в таблице 3. 

 
Таблица 3 – Графические примитивы нотации Process Landscape в ARIS Express 

Графическое представление Наименование Описание 

Принять
на работу

 

Process 
(процесс) 

Обозначает процесс  
или бизнес-процесс  

 

Hierarchy  
(иерархия  
процессов) 

Отображает иерархию  
процессов в организации 

 

Main processes 
(основные  
процессы) 

Отображает основные  
процессы организации,  
например, продажи, закупки, 
производство, маркетинг  
и т.д. 

 

Так, бизнес-процесс «Подобрать и нанять сотрудника» включает 
следующие подпроцессы: 

 «провести первичный подбор персонала на заявленную вакан-
сию»; 

 «оценить кандидата по результатам интервью, проверок»; 
 «принять на работу». 
Пример диаграммы Process Landscape для бизнес-процесса «По-

добрать и нанять сотрудника» представлен на рисунке П.1.1. 

1.3 Нотация BPMN 

Диаграмма BPMN (Business Process Model and Notation, нотация  
и модель бизнес-процессов) – нотация для моделирования бизнес-
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процессов, разработанная Business Process Management Initiative 
(BPMI.org), поддерживается Object Management Group, после слияния 
организаций в 2005 г. Последняя версия BPMN – 2.0.1. 

В 2013 г. Международная организация по стандартизации (ISO) 
опубликовала нотацию BPMN (версия 2.0.1) в качестве своего стандарта 
ISO/IEC 19510:2013 [19]. Целью этого стандарта служит представление 
нотации бизнес-процессов, которая устраняет разрыв между моделью  
и ее реализацией на практике. 

Основные примитивы нотации BPMN представлены в таблице 4. 
 

Таблица 4 – Графические примитивы нотации BPMN 

Графическое представление Наименование Описание 

1 2 3 

 

Lane (полоса) Служит для добавления пула 
или дорожки. Пулы – это  
стороны, взаимодействующие 
в рамках услуги (министерства, 
ведомства, заявитель),  
а дорожки – это ответственные 
исполнители (роли) внутри 
отдельного пула 

 

 

Start event  
(начальное  
событие) 

Начальное событие определяет 
старт любого процесса. 
Например, событие –  
получение сообщения 

 

  

Intermediate event 
(промежуточное 
событие) 

Промежуточное событие. 
Например, событие –  
отправка сообщения,  
событие – таймер – ожидание 

 

 

End event  
(конечное  
событие) 

Конечное событие определяет 
завершение процесса. 
Например, окончание  
процесса связано с событием – 
ошибка 

 

Task (задача) Действие (задача) отражает 
действие (процесс),  
осуществляемое 
ответственным лицом 
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Продолжение таблицы 4 

1 2 3 

 

   

Gateway (шлюз) Шлюз (логический оператор) – 
объект управления потоками 
данных. 
Например, «исключающее 
или», «или», «и» 

Пакет
документов
по заемщику

 

Data object  
(объект данных) 

Объект данных – данные  
в виде документа, журнала, 
реестра и т.п. 

База данных
Клиенты

 

Data store  
(хранилище  
данных) 

Хранилище данных –  
совокупность данных (база 
данных, архив документов) 

 
Модель бизнес-процесса «Подобрать и нанять сотрудника» в нота-

ции BPMN представлена на рисунке 4. 
 

Провести первичный
подбор персонала
на заявленную
вакансию

Оценить кандидата
по результатам

интервью, проверок

Принять на работу

 
 
Рисунок 4 – Подпроцессы процесса «Подобрать и нанять сотрудника»  

в нотации BPMN 
 
Границы подпроцесса «Провести первичный подбор персонала  

на заявленную вакансию»: вход – появление в организации вакансии  
в одном из подразделений, выход – список потенциальных претендентов 
на вакансию для организации личных собеседований и интервью в ком-
пании. 

Границы подпроцесса «Оценить кандидата по результатам интер-
вью, проверок»: вход – приглашение кандидата на собеседование, выход – 
положительное/отрицательное решение о приеме на работу (в случае 
положительного решения – личное заявление кандидата о приеме на ра-
боту, подписанное руководителем подразделения). 
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Границы подпроцесса «Принять на работу»: вход – подписанное 
заявление о приеме на работу, выход – вводный инструктаж по охране 
труда. 

Рассмотрим первый подпроцесс. Со стороны организации в нем 
участвуют: руководитель подразделения, в котором появилась вакансия, 
менеджер по подбору персонала, начальник отдела кадров. Внешний 
объект для процесса – кандидат на вакансию. 

Возможный вариант диаграммы подпроцесса «Провести первич-
ный подбор персонала на заявленную вакансию» в нотации BPMN пред-
ставлен в приложении 2 (рисунок П.2.1). 

1.4 Диаграмма бизнес­процесса 

Диаграмма бизнес-процесса (Business process diagram) пред-
ставляет собой классическую нотацию EPC. 

Event driven Process Chain, или расширенная цепочка процесса, 
управляемого событиями, используется для моделирования бизнес-про-
цессов. В нотации EPC описываются:  

 деятельность, осуществляемая в ходе процесса; 
 участвующие организационные подразделения, лица; 
 входные и выходные; 
 используемые IT-системы; 
 события, происходящие в процессе. 
Основные примитивы нотации EPC представлены в таблице 5. 
 

Таблица 5 – Графические примитивы нотации EPC 

Графическое представление Наименование Описание 

1 2 3 

Утвердить
программу
заполнения
вакансии

 

Activity 
(деятельность) 

Служит для описания  
процедур, функций, работ.  
Имя отглагольное  
существительное или глагол 

Появление
вакансии

 

Event (событие) Состояние системы, процесса, 
влияющее на выполнение 
функций или управляющее 
ими 

Кандидат

  

Entity (сущность, 
объект) 
 

Объекты систем, внешние 
объекты 
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Продолжение таблицы 5 

1 2 3 

График встреч
с кандидатами

 

Document  
(документ) 

Используется для отображения 
на диаграмме электронных 
документов, сопровождающих 
выполнение функции. Внутри 
блока помещается  
наименование электронного  
документа 

A3 Принять
на работу

 

Process interfac  
(интерфейс  
процесса) 

Элемент, обозначающий  
внешний (по отношению  
к текущей диаграмме) процесс 
или функцию. Используется 
для указания взаимосвязи 
процессов:  
– обозначает предыдущий 
или следующий процесс  
по отношению к диаграмме 
рассматриваемого процесса;  
– обозначает процесс, откуда 
поступил или куда передается 
объект. Внутри блока  
помещается наименование 
внешнего процесса 

 

IT-system  
(ИТ-система) 
 

Используется для отображения 
на диаграмме информационной 
системы, поддерживающей 
выполнение функции. Внутри 
блока помещается  
наименование  
информационной системы 

БД Резюме

 

Database  
(база данных) 

Используется для отображения 
на диаграмме базы данных, 
сопровождающей выполнение 
функции. Внутри блока  
помещается наименование  
базы данных 

 

Product  
(продукт) 

Используется для отображения 
на диаграмме продукта,  
получаемого в результате 
выполнения функции. Внутри 
блока помещается  
наименование продукта 
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Продолжение таблицы 5 

1 2 3 

Структурное
подразделение

 

Organizational unit 
(организационная 
единица) 

Используется для отображения 
на диаграмме организационных 
единиц (подразделения) –  
участников или исполнителей 
функций. Внутри блока  
помещается наименование  
организационной единицы 

Менеджер
по подбору
персонала

 

Role  
(роль, должность) 

Используется для отображения 
на диаграмме ролей,  
должностей – участников  
или исполнителей функций. 
Внутри блока помещается  
наименование роли, должности 

 

Подача заявки

Профиль
должности

есть

Профиля
должности нет

 

XOR rule  
(переход  
«исключающее 
или») 

Оператор «исключающего 
ИЛИ», управляемый событиями 
или действиями. При ветвлении 
направляет поток лишь  
по одной исходящей ветви  

 

 

OR rule (переход 
«включающее 
или») 

Оператор «включающего 
ИЛИ», управляемый события-
ми или действиями.  
При ветвлении, в зависимости 
от выполнения условий, 
активируется одна или более 
ветвей 

 

 

AND rule 
(переход «и») 

Оператор «и». При разделении 
на параллельные потоки все 
ветви активируются одновременно. 
При синхронизации параллельных 
ветвей оператор ждет  
завершения всех входящих 
ветвей и затем активирует  
выходной поток 

Заполнение
требований
к кандидату
на вакансию

 

Risk (риск) Акцентирует внимание  
на аспектах деятельности,  
которые имеют решающее  
значение для успешности  
процесса 
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Пример диаграммы бизнес-процесса «Провести первичный подбор 
персонала на заявленную вакансию» в нотации eEPC представлен  
на рисунке П.3.1. 

1.5 Модель данных, карта систем,  
ИТ­инфраструктура 

Модель данных (Data model) позволяет провести анализ предмет-
ной области: представить бизнес-объекты и отношения между ними.  

Основные примитивы нотации Data model показаны в таб- 
лице 6. 

 
 

Таблица 6 – Графические примитивы нотации Data model в ARIS Express 

Графическое представление Наименование Описание 

Сотрудник

 

Entity 
(сущность) 

Отображает объект реального 
мира  

ID сотрудника

 

Primary key  
(первичный  
ключ) 
 

Задает уникальный  
идентификатор экземпляров 
объекта 

Дата приема
на работу

 

Attribute  
(атрибут) 

Задает свойство объекта 

ID
руководителя

 

Foreign key 
(внешний ключ) 

Указывает на наличие ссылки 
на первичный ключ другой 
сущности (объекта) 

 
Фрагмент модели данных для предметной области – управление 

персоналом – представлен на рисунке 5. 
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Сотрудник

ID сотрудника

ФИО

ID
подразделен...

Дата приема
на работу

Подразделение

ID подразделения

Название

ID
руководителя

работает в

руководит

 
 

Рисунок 5 – Модель данных (фрагмент) 
 
Карта систем (System landscape) показывает, какие информацион-

но-технологические решения используются в организации, и группирует 
их по некоторому признаку. Основные примитивы нотации System 
landscape представлены в таблице 7. 

 

Таблица 7 – Графические примитивы нотации System landscape в ARIS Express 

Графическое представление Наименование Описание 

ERP

 

Domain 
(домен) 

Домен отображает  
группировку ИТ-систем  
в области по различным  
критериям объединения 
 

 Клиенты (CRM)

 

IT-system  
(ИТ-системы) 
 

Программная система 

 

На рисунке 6 представлена карта систем для ERP-системы 
(Enterprise Resource Planning, планирование ресурсов предприятия). 
ERP-система включает в себя отдельные модули, например CRM-систему 
(Customer Relationship Management, управление взаимоотношениями  
с клиентами). 
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ERP‐система

Финансы Торговля Персонал

 Клиенты (CRM) Логистика Производство

 
 

Рисунок 6 – Карта систем 
 

На карте систем представлены четыре платформы ARIS (рисунки 7–10). 
 

ARIS Strategy Platform

ARIS Business
Optimizer

ARIS BSC
(Balanced
Scorecard)

ARIS Six Sigma

 
 

Рисунок 7 – ARIS Strategy Platform 
 

ARIS Design Platform

ARIS Business
Architect

ARIS Business
Designer

ARIS Business
Publisher

ARIS IT Architect ARIS IT Inventory
ARIS ArchiMate

Modeler

ARIS for Defence
Solutions

ARIS Business
Simulator

 
Рисунок 8 – ARIS Design Platform 
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ARIS Controlling Platform

ARIS Risk &
Complance
Manager

ARIS Pricess
Performance
Manager

ARIS Process Event
Monitor

ARIS Performance
Dashboard

 
 

Рисунок 9 – ARIS Controlling Platform 
 
 
 

 
 

Рисунок 10 – ARIS Implementation Platform 



 23

ИT-инфраструктура (IT-infrastructure) моделирует технические 
решения: 

 какое программное обеспечение и аппаратное обеспечение ис-
пользуется в компании; 

 в какие сети объединено аппаратное обеспечение; 
 какое сетевое оборудование используется. 
Основные примитивы нотации IT-infrastructure представлены  

в таблице 8. 
 

Таблица 8 – Графические примитивы нотации IT-infrastructure в ARIS Express 

Графическое представление Наименование Описание 

Firewall

 

Network  
component  
(сетевой  
компонент) 

Сетевой компонент (свич,  
роутер, файрвол) позволяет 
отобразить технические  
решения в сети 

Internet

 

Network (сеть) 
 

Отдельные сетевые устройст-
ва, связанные единой техно-
логией 

 

Hardware  
(аппаратное  
обеспечение) 

Сетевые устройства 

CRM система

 

IT-system  
(ИТ-система) 

Программная система 

 
ИТ-инфраструктура компании, бизнес-модель которой включа- 

ет продажи, представлена на рисунке 11. CRM система (Customer 
Relationship Management) – это система управления взаимоотношениями 
с клиентами. 
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CRM система

OS Windows

Switch Firewall Internet

 
 

Рисунок 11 – ИТ-инфраструктура  

1.6 Доска, общие диаграммы 

Доска (Whiteboard) моделирует флип-чарт и клеящиеся записки, 
но может быть использована, например, для представления BSC 
(Balanced Scorecard – сбалансированной системы показателей).  

Область построения диаграммы Whiteboard изображена на рисунке 12. 
 

 
 

Рисунок 12 – Область построения диаграммы Whiteboard 
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Основные примитивы нотации Whiteboard представлены в таблице 9. 
 

Таблица 9 – Графические примитивы нотации Whiteboard в ARIS Express 

Графическое представление Наименование Описание 

Управление
взаимоотношениями

 с клиентами

 

Stage 
(сценарий) 

Сценарий используется  
для логической группировки 
действий и целей  

Привлечение новых
клиентов

 

Activity  
(деятельность) 

Описывает действия, которые 
должны быть совершены  
в определенном сценарии 

Увеличение
прибыльности
компании  

Overall goal  
(глобальная цель) 

Глобальная цель  
определяется сразу  
для нескольких сценариев 

Рост
клиентской базы

 

Goal (цель) Определяет конечный результат 
для отдельных сценариев 

 Карты постоянного покупателя,
рассылки для групп клиентов

 

Detail  
(детализация) 

Используется для включения 
в сценарий дополнительной 
информации 

Число новых клиентов
за последний месяц

 

KPI instance  
(примеры ключевых 
показателей  
эффективности) 

Используется для определения 
метрик и показателей 
успешности реализации 
деятельности в сценарии 

 

Пример диаграммы Whiteboard на рисунке 13.  
 

 
 

Рисунок 13 – Сценарии для достижения глобальной цели (фрагмент)  
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Общие диаграммы (General diagram) используются для построе-
ния самых разных схем, так как имеют большой арсенал базовых графи-
ческих примитивов (таблица 10).  

 
Таблица 10 – Графические примитивы нотации General diagram в ARIS Express 

Графическое представление 

Rectangle

 

Parallelogram

 

Symmetric
trapezoid

 

Diamond

 

Octogon

 

Triangle
(left)

 

Triangle
(right)

 

Triangle
(up)

 

Triangle
(down)

 

Hexagon

 

Asymmetric trapezoid

 

Rectangular pentagon

 

Circle

 

Cube

 

Ellipse

 

Cross

 

Document

 

Display

 

Information

 

Storage

 

Cloud

 

Rectangle with
lines

 

Folded corner

 

Split diamond
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Бизнес-архитектура предприятия, построенная на основании шаб-
лона ARIS House, представлена на рисунке 14.  

 

Бизнес‐архитектура

Организационная
структура

Бизнес‐
процессы

Система
документооборота

 
 

Рисунок 14 – Бизнес-архитектура предприятия  
(шаблон ARIS House) 

 
На рисунке 15 на основании готового шаблона Mind map изобра-

жены составляющие стратегии предприятия.  
 

Стратегия
предприятия

Организационная

Маркетинговая

Инвестиционная Финансовая

Инновационная

Социально‐
кадровая

 
 

Рисунок 15 – Стратегия предприятия (шаблон Mind map) 
 
На рисунке 16 изображена схема взаимодействия 1С с информаци-

онными базами. 
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Тонкий клиент

Веб‐клиент

1C

1C

Информационная
база

  
 
Рисунок 16 – Схема взаимодействия 1С с информационными базами 
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2 РЕДАКТОР ARIS EXPRESS 

2.1 Установка и конфигурирование  
ARIS Express 

ARIS Express – open source, дистрибутив можно загрузить для ус-
тановки на официальном сайте http://www.ariscommunity.com/aris-
express. 

При первом запуске ARIS Express необходимо сконфигурировать. 
Мастер конфигурирования потребует зарегистрировать установку про-
граммного обеспечения, для этого необходимо ввести логин/пароль  
на ARIS Community. Получить их можно, заполнив форму  
на http://www.ariscommunity.com/user/register (рисунок 17). Для регист-
рации на ARIS Community потребуется e-mail address, заполнять  
на вкладках можно только обязательные поля.  

 
 

 
 

Рисунок 17 – Регистрация на ARIS Community 
 

Четыре шага мастера конфигурирования ARIS Express представле-
ны на рисунках 18–21. 
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Рисунок 18 – Стартовое окно мастера конфигурирования 
 

 
 

Рисунок 19 – Лицензионное соглашение 
 

 
 

Рисунок 20 – Регистрация установки на ARIS Express 
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Рисунок 21 – Выбор языка интерфейса ARIS Express 

2.2 Создание моделей средствами ARIS Express 
Освоение инструментального средства ARIS Express моделирова-

ния элементов бизнес-архитектуры предприятия начнем с построения 
организационной диаграммы. Выберем пиктограмму Organizational chart  

в начальном окне  или в командном меню File > New model > > Or-
ganizational chart. В верхней части построения диаграммы – стандартное 
командное меню приложений, работающих под операционной системой 
Windows. 

Окно построения диаграммы разделено на пять областей (рисунок 22): 
 область просмотра и редактирования атрибутов модели; 
 область построения диаграммы (в верхней части расположены 

вкладки, позволяющие перемещаться между диаграммами, открытыми  
в текущем сеансе работы в продукте ARIS); 

 область, в которой отображаются пиктограммы доступных объ-
ектов для построения модели; 

 область, в которой размещаются доступные шаблоны, для орга-
низационных диаграмм; 

 область просмотра окончательного варианта модели. 
Если какие-либо области недоступны при создании новой модели, 

их можно подключить с помощью командного меню View > Model over-
view/Attributes/Symbols/Fragments. 

На рисунке 23 открыта вкладка построения диаграммы Business 
process, и для представленной обширной модели бизнес-процесса в но-
тации EPC очевидны преимущества просмотра общего вида модели в 
области Model overview.  
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Рисунок 22 – Окно построения диаграммы Organizational chart 

 
 

 
 

Рисунок 23 – Окно построения диаграммы Business process 
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Для каждого выделенного элемента становится доступна панель 
hot-spots, это реализация в ARIS Express концепции контекстно-чувст-
вительного моделирования. В панели hot-spots, доступной для выделен-
ного объекта, отображены символы, которые можно использовать для 
соединения с данным объектом, на данном шаге моделирования.  

Ненужные области можно закрыть (кроме собственно области по-
строения диаграммы, ее закрытие приводит к закрытию соответствую-
щей модели) и, как в любом оконном приложении, размером областей 
можно управлять.  

Для задания атрибутов модели в командном меню выберите опции 
Format > Representation (Формат > Представление) и в открывшемся 
окне введите название проекта и его описание (рисунок 24).  

 

 
 

Рисунок 24 – Окно свойств модели Organizational chart 
 

Если в область построения модели добавлены объекты и один из 
них выделен, то откроется не окно настройки свойств модели, а окно на-
стройки свойств выделенного объекта (рисунок 25).  

На вкладке Information можно получить информацию о месте со-
хранения файла File path – путь к файлу (если сохранения диаграммы  
в файл не было, то поле останется пустым), о языке модели Model 
language и о типе модели Model type (рисунок 26). 
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Рисунок 25 – Окно свойств объекта Organizational unit 
 

 
 

Рисунок 26 – Вкладка Information 
 

Язык модели можно изменить с помощью опции командного меню 
View > Options > Model language и из списка выбрать нужный.  

Для выделенного объекта модели в области просмотра и редакти-
рования атрибутов (см. рисунок 24) выбрать:  

 Name – имя объекта;  
 Description – описание объекта; 
 Autor – автор. Диаграмму могут редактировать различные поль-

зователи, поэтому важно знать, кто добавил тот или иной объект на диа-
грамму; 

 Link – ссылка на документ или другую диаграмму ARIS Express.  
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Пояснительный текст на диаграмму поместим в прямоугольник  
со скругленными краями. Он добавляется с помощью пиктографическо-

го меню , в раскрывающемся списке доступ-
ных графических объектов следует выбрать Insert-Rounded Rectangle 
(Вставить/ Скругленный прямоугольник). Иначе – используем команд-
ное меню Insert>Rounded Rectangle. 

Настроим формат графического объекта, вызвав контекстное меню 
для этого объекта щелчком правой кнопки мыши на нем: 
Format > Representation (или из командного меню ту же последователь-
ность). Изменим цвет заливки на светло-серый и используем 3D-эффект 
(рисунок 27). 

 

 
 

Рисунок 27 – Окно свойств Graphic object 
 

В поле прямоугольника добавим объект, позволяющий вводить 
произвольный текст командой Insert > Free-Form Text (Вставить/Текст 
свободной формы). Вызываем окно настройки свойств объекта 
Format > Representation (рисунок 28) и задаем нужные значения пара-
метров. 

 

 
 

Рисунок 28 – Окно свойств Text 
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Результат представлен на рисунке 29. 
 

Служба управления
персоналом

Отдел кадров Отдел обучения
и развития

Отдел труда
и заработной платы

Цель моделирования - уточнить
функции в бизнес-процессах
управления персоналом

сотрудников кадровой службы

 
 

Рисунок 29 – Результат добавления пояснений в модель 

2.3 Создание моделей  
с помощью инструмента SmartDesign 

При построении диаграмм можно использовать специальный инст-
румент SmartDesign. Он доступен для всех моделей, кроме Whiteboard и 

BPMN diagram, в пиктографическом меню  или 
командном меню Edit > SmartDesign. 

На палитре пиктографического меню в диалоговом окне  
SmartDesign есть несколько управляющих кнопок (рисунок 30), позво-
ляющих:  

 добавить объект (1); 
 удалить выделенный объект (2);  
 переместить на один уровень выше/ниже (3–4) в уровне иерар-

хий организационную единицу (кнопка активна только при конструиро-
вании организационных диаграмм);  

 поднять/опустить на один уровень событие или функцию (5–6); 
 использовать стандартные для интерфейса Windows кнопки 

Undo/Redo (7–8);  
 настроить поля, которые будут отображаться в таблице при кон-

струировании объектов диаграммы (9). 
 

 
 

Рисунок 30 – Палитра пиктографического меню  
для инструмента SmartDesign 
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Рассмотрим возможности SmartDesign на примере построения ор-
ганизационной диаграммы (рисунок 31). 

 

 
 

Рисунок 31 – Диаграмма организационной структуры Службы управления  
персоналом (с ошибками в структуре) 

 

Переместим Службу управления персоналом на уровень выше  
в иерархии (рисунок 32,а), опустим на уровень ниже Отдел кадров (ри-
сунок 32,б), понизим уровень в иерархии для Отдела кадров (рису- 
нок 32,в), удалим роль Менеджер по подбору персонала у организаци-
онной единицы Служба управления персоналом (рисунок 32,г), добавим 
роль Менеджер по подбору персонала у организационной единицы От-
дел кадров (рисунок 32,д). 

 

 
а) 

 

 
б) 

Рисунок 32 – Исправление ошибок 
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в) 
 

 
г) 

 

 
д) 

Рисунок 32 – Окончание 
 

Итоговый вариант корректной оргструктуры Службы управления 
персоналом представлен на рисунке 33. 

 

 
 

Рисунок 33 – Корректная диаграмма организационной структуры  
Службы управления персоналом 
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Рассмотрим построение бизнес-процесса «Прием на работу» в но-
тации EPC (Business process) с помощью SmartDesign (рисунок 34). 

 

 
 

Рисунок 34 – Бизнес-процесс «Прием на работу»  
в нотации EPC (Business process) 

 
Процесс конструирования фрагмента диаграммы Business process  

с использованием SmartDesign происходит достаточно просто: нужно 
задать название функции (Activity) и в строчке с названием данной 
функции прописать название всех объектов, которые образуют окруже-
ние данной функции, завершая ввод каждого названия нажатием клави-
ши Enter. При этом объекты, которым даны названия, возникают, распо-
лагаются на диаграмме и связываются с функцией автоматически, 
используя правила, разработанные разработчиками ARIS Express. 

Добавление объектов в столбцы таблицы представлено на рисунке 35.  
 

 
Рисунок 35 – Добавление объектов в процесс 
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Дополнительные объекты можно описывать для Activity (действия) 
и нельзя для Event (событий). В этом большое преимущество инстру-
мента SmartDesign: он контролирует соблюдение правил построения 
диаграммы. 

Диалоговое окно кнопки Show columns позволяет добавлять и уда-
лять столбцы с объектами, которые будут доступны при создании диа-
граммы с помощью SmartDesign (рисунок 36). 

 

 
 

Рисунок 36 – Диалоговое окно кнопки Show columns 
 

На рисунке 37 представлено использование инструмента SmartDesign 
для создания диаграммы Data model. 

 

 
 

Рисунок 37 – Диаграмма Data model, созданная с использованием 
SmartDesign 
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3 ЛАБОРАТОРНЫЕ РАБОТЫ 
Основные требования к оформлению отчетов по лабораторным ра-

ботам: 
1 Отчет предоставляется в электронном виде в файле с расширени-

ем .pdf. 
2 Титульный лист отчета оформляется согласно приложению 4. 
3 Текст отчета оформляется следующим образом:  
 поля: левое – 30 мм, правое – 10 мм, верхнее – 20 мм, нижнее –

20 мм; шрифт размером 13 или 14 пт, гарнитурой Times New Roman; 
 межстрочный интервал – полуторный; отступ – 1,25; выравнива-

ние текста – по ширине; 
 каждый структурный элемент содержания начинается с новой 

страницы; 
 наименование структурных элементов следует располагать  

по центру строки без точки в конце, без подчеркивания, отделяя от тек-
ста двумя межстрочными интервалами; 

 иллюстрации следует располагать в работе непосредственно по-
сле текста, в котором они упоминаются впервые. На все иллюстрации 
должны быть ссылки в работе. Иллюстрации (чертежи, графики, схемы, 
документы, рисунки, снимки) должны быть пронумерованы и иметь на-
именование и пояснительные данные под иллюстрацией;  

 таблицы располагаются в работе непосредственно после текста, 
в котором они упоминаются впервые, или на следующей странице.  
На все таблицы должны быть ссылки в тексте. Наименование таблицы 
помещается над таблицей слева без абзацного отступа. 

Требования к содержанию отчета: 
 в основной части отчета приводят данные, отражающие сущ-

ность, методику и основные результаты выполненной работы; 
 содержание основной части должно включать:  
а) цели лабораторной работы; 
б) задачи, необходимые для достижения целей в процессе выпол-

нения работы;  
в) ход работы, содержащий описание выполненных действий; 
г) заключение. 

Л а б о р а т о р н а я  р а б о т а  № 3.1  

ДИАГРАММА ОРГАНИЗАЦИОННОЙ СТРУКТУРЫ 
Цель работы: построить диаграмму Organizational chart для пред-

приятия. 
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Формируемые знания, умения и навыки: изучить основные 
принципы создания диаграмм в ARIS Express и получить базовые навы-
ки разработки Organizational chart. 

Необходимо: 
1 Для предприятия определить объекты организационной структу-

ры в границах рассматриваемого бизнес-процесса. 
Провести анализ организационной структуры предприятия в гра-

ницах рассматриваемого процесса: участники процесса со стороны ор-
ганизации (непосредственные исполнители операций, потребители про-
межуточных и конечных результатов процесса, участники процесса, 
осуществляющие текущий мониторинг всего процесса или отдельных 
операций, и т.п.), иерархия их подчинения. 

2 Построить диаграмму Organizational chart: объекты, связи между 
ними и т.п. (настройка атрибутов объектов). 

Контрольные вопросы и задания 

1 Какие объекты доступны при построении Organizational chart? 
2 Какие типы связей доступны при построении Organizational 

chart? 
3 Дайте описание атрибута Link и его настроек. 
4 Какую концепцию поддерживает панель hot-spots для Organiza-

tional chart? 
5 Какой элемент пиктографического меню используется для раз-

мещения на диаграмме Organizational chart пояснений и заметок? 

Л а б о р а т о р н а я  р а б о т а  № 3.2  

ДИАГРАММА В НОТАЦИИ BPMN 

Цель работы: построить диаграмму бизнес-процесса организации 
в нотации BPMN.  

Формируемые знания, умения и навыки: изучить основные 
принципы создания диаграмм в ARIS Express и получить базовые навы-
ки разработки диаграммы процесса в нотации BPMN. 

Необходимо: 
1 Для рассматриваемого бизнес-процесса организации определить 

типовой ход процесса: 
 тип начального события, конечного события, типы промежуточ-

ных событий (при их наличии в процессе); 
 участников процесса и зоны их ответственности (воспользовать-

ся Organization chart лабораторной работы № 3.1); 
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 список операций, последовательность выполнения, ветвления 
(если есть) и их тип; 

 для операций и подпроцессов при необходимости объекты дан-
ных и хранилища данных. 

2 Построить диаграмму бизнес-процесса в нотации BPMN: опера-
ции (задачи, подпроцессы), связи между ними и т.п. (настройка атрибу-
тов объектов). 

Контрольные вопросы и задания 

1 Какие объекты доступны при построении диаграммы бизнес-
процесса в нотации BPMN? 

2 Для каких целей используются элементы Pool и Line? 
3 Дайте описание атрибута Link и его настроек. 
4 Опишите возможные типы стартовых событий и приведите при-

меры их использования. 
5 Опишите возможные типы промежуточных событий и приведите 

примеры их использования. 
6 Опишите возможные типы конечных событий и приведите при-

меры их использования. 
7 Опишите возможные типы задач бизнес-процесса и приведите 

примеры их использования. 
8 Опишите возможные типы шлюзов и приведите примеры их ис-

пользования. 

Л а б о р а т о р н а я  р а б о т а  № 3.3  

ДИАГРАММА EPC  
(EVENT DRIVEN PROCESS CHAIN) 

Цель работы: построить диаграмму бизнес-процесса организации 
в нотации EPC.  

Формируемые знания, умения и навыки: изучить основные 
принципы создания диаграмм в ARIS Express и получить базовые навы-
ки разработки диаграммы бизнес-процесса EPC. 

Необходимо: 
1 Скорректировать описание бизнес-процесса (лабораторная рабо-

та № 3.2) с учетом требований, предъявляемых к нотации EPC, определить: 
 последовательность действий и событий, при ветвлении – типы 

перекрестков; 
 организационные единицы для действий бизнес-процесса (вос-

пользоваться Organization chart лабораторной работы № 3.1); 
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 элементы окружения бизнес-процесса: сущности, документы, 
информационные системы и т.п.; 

 для операций и подпроцессов при необходимости объекты дан-
ных и хранилища данных. 

2 Построить диаграмму бизнес-процесса в нотации EPC, используя 
SmartDesign. 

Контрольные вопросы и задания 

1 Какие объекты доступны при построении диаграммы бизнес-
процесса в нотации EPC? 

2 Назовите правила следования действий и событий на диаграмме 
EPC. 

3 Опишите возможные типы перекрестков, используемые при 
ветвлении, приведите примеры их использования. 

4 Какие элементы используются для описания окружения бизнес-
процесса в нотации EPC? 

Л а б о р а т о р н а я  р а б о т а  № 3.4 

ДИАГРАММА PROCESS LANDSCAPE 

Цель работы: построить диаграмму карты процессов для органи-
зации.  

Формируемые знания, умения и навыки: изучить основные 
принципы создания диаграмм в ARIS Express и получить базовые навы-
ки разработки Process Landscape. 

Необходимо: 
1 Для предприятия определить дерево процессов, связанных с од-

ним из видов деятельности организации. 
Определить группу процессов в этом виде деятельности, выстро-

ить их иерархию. 
2 Построить диаграмму Process Landscape: при условии, что для 

какого-либо процесса, включенного в диаграмму Process Landscape, ранее 
построена диаграмма в нотации BPMN или EPC, настроить с ними связь. 

Контрольные вопросы и задания 

1 Какие объекты доступны при построении Process Landscape? 
2 Какие основные виды деятельности можно выделить для рас-

сматриваемой организации (процессы верхнего уровня)? 
3 Как определяется иерархия в группе процессов, реализующих 

один из видов деятельности организации? 
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Рисунок П.1.1 – Диаграмма ARIS в нотации Process Landscape  
для бизнес-процесса «Подобрать и нанять сотрудника» 
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ПРИЛОЖЕНИЕ 3 
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Рисунок П.3.1 – Диаграмма ARIS в нотации eEPC  

«Провести первичный подбор персонала на заявленную вакансию»
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